The Fundamentals of SolidWorks® 2008

Featuring the VEXplorer™ robot with over 50 integrated stand alone tutorials and Supplemental materials on the CO₂ Race Car and Vex Robotics Design System

By David C. Planchard & Marie P. Planchard CSWP

2008 Model Files
Over 50 Tutorials with model files

INSIDE:
2008 Model Files
Over 50 Tutorials with model files

SDC
PUBLICATIONS
 Schroff Development Corporation

www.schroff.com
Chapter 1: Quick Start

Chapter Objective

Chapter 1 provides a basic overview of the concepts and terminology used throughout this book using SolidWorks® 2008 software. If you are completely new to SolidWorks, you should read Chapter 1 in detail and complete Lesson 1, Lesson 2, and Lesson 3 in the SolidWorks Tutorials under Help, SolidWorks Tutorials, Getting Started from the Menu bar menu.

If you are familiar with an earlier release of SolidWorks, you still might want to skim this chapter to get acquainted with the feature and interface enhancements that have been incorporated into 2008.

Chapter 1 introduces many basic operations of SolidWorks such as; definitions, starting a SolidWorks session, understanding the SolidWorks User Interface (UI) and CommandManager, FeatureManager Design Tree, Shortcut toolbars, Heads-up View toolbar, Task Pane, along with opening and closing documents, creating a 2D Sketch, 3D Part, 3D Assembly, and a Multi-view 2D Drawing.

SolidWorks 2008 has had a major user interface enhancement along with additional tutorials, features, tools, etc. The SolidWorks 2008 (UI) has been redesigned to make maximum use of the Graphics window space for your model. Displayed toolbars and commands are kept to a minimum.

On the completion of this chapter, you will be able to:

- Comprehend what is SolidWorks
- Understand basic concepts in SolidWorks:
  - Document, Model, Feature, Base sketch, Refining the design, Associativity, Drawing, and Geometric constraints
- Start a SolidWorks session
Quick Start

- Use the SolidWorks User Interface (UI) and CommandManager:
  - Menu Bar toolbar, Menu Bar menu, Drop-down menu, Right-Click Pop-up menus, Consolidated flyout tool buttons, System feedback, Confirmation Corner, and Heads-up View toolbar
- Know the FeatureManager Design Tree:
  - Show or Hide
  - Filter
  - Fly-out FeatureManager
- Comprehend the Task Pane:
  - SolidWorks Resources, Design Library, File Explorer, Search, View Palette, RealView, and Document Recovery
- Create a New 2D Sketch and a 3D Part
- Create a New 3D Assembly:
  - Insert Components and Standard Mates
- Create a New 2D Assembly Drawing:
  - Insert four standard views: Front, Top, Right, and Isometric

What is SolidWorks?

The SolidWorks application is a mechanical design automation software package used to create parts, assemblies, and drawings which takes advantage of the familiar Microsoft Windows graphical user interface.

SolidWorks is an easy to learn tool to design and analysis; (COSMOSWorks, COSMOSFloWorks, and COSMOSMotion) which makes it possible for designers to quickly sketch 2D and 3D concept sketches, create 3D parts and assemblies, and detail 2D drawings.
In SolidWorks, part, assembly, and drawing are all related as illustrated. The book is focused for the new user and assumes that you have little or no working knowledge of SolidWorks.

**Basic Concepts in SolidWorks**

Below is a list of basic concepts in SolidWorks to review and to comprehend. These concepts are applicable to all versions of SolidWorks. All of these concepts are addressed in this book.

- *A SolidWorks model.* Consists of 3D solid geometry in a part or assembly document. SolidWorks features start with either a 2D or 3D sketch. You can either import a 2D or 3D sketch or you can create the sketch in SolidWorks.

- *Features.* Individual shapes created by Sketch Entities tools: Lines, Circles, Rectangles, etc. that when combined, creates the part. Features can also be added to assemblies. Some features originate as sketches; other features, such as shells or fillets, are created when you select the appropriate tool or menu command and define the dimensions or characteristics that you want.

- *Base sketch.* The first sketch of a part is called the Base sketch. The Base sketch is the foundation for the 3D model. Create a sketch on a default plane or created reference plane. The default planes are: Front, Top, and Right Plane in the FeatureManager design tree.

- *Refining the design.* Adding, editing, or reordering features in the FeatureManager design tree. Example: For a part document, you can perform the following types of feature editing operations:
  - Edit the definition, the sketch, or the properties of a feature.
  - Control the access to selected dimensions.
  - Roll back the part to the state it was in before a selected feature was added.
  - View the parent and child relationships of a feature.
  - Use the feature handles to move and resize features.
  - Modify the order in which features are reconstructed when the part is rebuilt.

- *Associativity.* A SolidWorks model is fully associative. Associativity between parts, sub-assemblies, assemblies, and drawings, assures that changes incorporated in one document or drawing view are automatically made to all other related documents and drawing views.

- *Drawings.* Create 2D drawings of the 3D solid parts and assemblies which you design. Parts, assemblies, and drawings are linked documents. This means that any change incorporated into the part or assembly changes the drawing document. A
drawing generally consists of several views generated from the model. Views can also be created from existing views. Example: The Section or Projected view is created from an existing drawing view.

- **Constraints.** SolidWorks supports numerous constraints. Constraints are geometric relationships such as Perpendicular, Horizontal, Parallel, Vertical, Coincident, Concentric, etc. Use equations to establish mathematical relationships between parameters. Apply equations and constraints to your model to capture and maintain design intent.

## Starting a SolidWorks Session

Start a SolidWorks session and familiarize yourself with the SolidWorks User Interface (UI). As you read and perform the tasks in this chapter, you will obtain a sense on how to use this book and the structure. To help you learn the material, short quick tutorials are provided throughout the chapters. Actual input commands or required action to perform functions in the tutorial is displayed in bold.

SolidWorks is designed to run on Windows XP Professional or Vista 32 bit with a minimum of 512 MB RAM. View the SolidWorks website for additional system information and requirements.

The book was written using SolidWorks Office 2007 on Windows XP Professional SP2.1 with a Windows Classic desktop theme. Start a SolidWorks session. The SolidWorks application is located in the Programs folder.

### Tutorial: Start a SolidWorks Session 1-1

1. Click **Start ➔ All Programs ➔ SolidWorks 2008 ➔ SolidWorks 2008** from the Windows taskbar. The SolidWorks program window opens as illustrated. *Do not open a document at this time.*

If you do not see this screen, click the **SolidWorks Resources** icon in the Task Pane on the right side of the SolidWorks Graphics window.
2. **Read** the Tip of the Day.

💡 Double-click the **SolidWorks 2008 icon** in the Windows Desktop to start a SolidWorks session.


---

## SolidWorks User Interface (UI)

The Menu bar toolbar SolidWorks 2008 (UI) is redesigned to make maximum use of the Graphics window area. The default Menu bar toolbar contains a set of the most frequently used tool buttons. The available tools are:

- **New** — Creates a new document.
- **Open** — Opens an existing document.
- **Save** — Saves an active document.
- **Print** — Prints an active document.
- **Undo** — Reverses the last action.
- **Rebuild** — Rebuilds the active part, assembly, or drawing.
- **Options** — Changes system options and Add-Ins for SolidWorks.
Menu bar menu

Click SolidWorks in the Menu bar toolbar to display the Menu bar menu. SolidWorks provides a Context-sensitive menu structure. The menu titles remain the same for all types of documents; (part, assembly, and drawing) but the menu items change depending on which type of document is active.

Example: The Insert menu includes features in part documents, mates in assembly documents, and drawing views in drawing documents. The display of the menu is also dependent on the work flow customization that you have selected. The default menu items for an active document are: File, Edit, View, Insert, Tools, Window, Help, and Pin.

The Pin tool displays the Menu bar toolbar and the Menu bar menu as illustrated. Throughout the book, the Menu bar menu and the Menu bar toolbar is referred to as the Menu bar.

Drop-down menus

SolidWorks takes advantage of the familiar Microsoft® Windows® user interface. Communicate with SolidWorks either through the drop-down menu, pop-up menu, shortcut toolbar, flyout toolbar or the CommandManager. A command is an instruction that informs SolidWorks to perform a task.

In SolidWorks, each part, assembly, and drawing is referred to as a document, and each document is displayed in a separate window.

To close a SolidWorks drop-down menu, press the Esc key. You can also click any other section in the SolidWorks Graphics window, or click another drop-down menu.

Right-click Pop-up menus

Right-click in the Graphics window either on a model, or in the FeatureManager on a feature or sketch to display a Context-sensitive shortcut toolbar. If you are in the
middle of a command, the toolbar displays a list of options specifically related to that command.

**Flyout tool buttons / Consolidated menus**

Similar commands are grouped into Consolidated buttons on toolbars and the CommandManager. Example: Variations of the rectangle tool are consolidated together in a button with a flyout control as illustrated. Select the drop-down arrow and view the available tools.

If you select the flyout button without expanding:

- For some commands such as Sketch, the most commonly used command is performed. This command is the first listed and the command shown on the button.

- For commands such as rectangle, where you may want to repeatedly create the same variant of the rectangle, the last used command is performed. This is the highlighted command when the flyout tool is expanded.

**System feedback icons**

SolidWorks provides system feedback by attaching a symbol to the mouse pointer cursor arrow. The system feedback symbol indicates what you are selecting or what the system is expecting you to select. As you move the mouse pointer across your model, system feedback is provided.
Confirmation Corner

When numerous SolidWorks commands are active, a symbol or a set of symbols are displayed in the upper right corner of the Graphics window. This area is called the Confirmation Corner.

When a sketch is active, the confirmation corner box displays two symbols. The first symbol is the sketch tool icon. The second symbol is a large red X. These three symbols supply a visual reminder that you are in an active sketch. Click the sketch symbol icon to exit the sketch and to saves any changes that you made.

When other commands are active, the confirmation corner box provides a green check mark and a large red X. Use the green check mark to execute the current command. Use the large red X to cancel the command.

Heads-up View toolbar

SolidWorks provides the user with numerous view options from the Standard Views, View, and Heads-up View toolbar.

The Heads-up View toolbar is a transparent toolbar that is displayed in the Graphics window when a document is active. You can’t hide nor move the Heads-up View toolbar. The following views are available:

Views in the Heads-up View toolbar are document dependent.

- **Zoom to Fit**: Zooms the model to fit the Graphics window.
- **Zoom to Area**: Zooms to the areas you select with a bounding box.
- **Previous View**: Displays the previous view.
- **Section View**: Displays a cutaway of a part or assembly, using one or more cross section planes.
- **View Orientation**: Provides the ability to select a view orientation or the number of viewports. The available options are: Top, Isometric, Trimetric, Dimetric, Left, Front, Right, Back, Bottom, Single view, Two view - Horizontal, Two view - Vertical, Four view.
• **Display Style**  
  Provides the ability to display the style for the active view. The available options are: *Wireframe, Hidden Lines Visible, Hidden Lines Removed, Shaded, Shaded With Edges*.

• **Hide/Show Items**  
  Provides the ability to select items to hide or show in the Graphics window. Note: The available items are document dependent.

• **Apply Scene**  
  Provides the ability to apply a scene to an active part or assembly document. View the available options.

• **View Setting**  
  Provides the ability to select the following: *RealView Graphics, Shadows in Shaded Mode, and Perspective*.

• **Rotate**  
  Provides the ability to rotate a drawing view.

• **3D Drawing View**  
  Provides the ability to dynamically manipulate the drawing view to make a selection.

- The default document setting displays reference planes and the grid in the Graphics window. To deactivate the reference planes for an active document, click **View**, uncheck **Planes** from the Menu bar. To deactivate the grid, click **Options**, **Document Properties** tab. Click **Grid/Snaps**, uncheck the **Display grid** box.

- To deactivate a single reference plane in an active document, right-click the selected plane, click **Hide**.

- To view a needed toolbar, click **View, Toolbar** from the Menu bar menu. Select the required toolbar.

- To deactivate the Origins in the Graphics window, click **View**, uncheck **Origins** from the Menu bar menu.
CommandManager

The CommandManager is document dependent. Drop-down tabs are located on the bottom left side of the CommandManager and display the available toolbars and features for each corresponding tab. The default Part tabs are: Features, Sketch, Evaluate, DimXpert, and Office Products.

Below is an illustrated CommandManager for a default Part document.

💡 The Office Products toolbar display is dependent on the activated Add-Ins.. during a SolidWorks session.

💡 If you have SolidWorks Office, SolidWorks Office Professional, or SolidWorks Office Premium, the Office Products tab is displayed in the CommandManager. The book was written with SolidWorks Office Premium using version SP2.1
Below is an illustrated CommandManager for a default Drawing document. The default Drawing tabs are: *View Layout, Annotation, Sketch, Evaluate, and Office Products*. Note: In older SolidWorks versions, the Annotation tab is named Annotate.

💡 The Office Products toolbar display is dependent on the activated Add-Ins. during a SolidWorks session.

💡 If you have SolidWorks Office, SolidWorks Office Professional, or SolidWorks Office Premium, the Office Products tab is displayed in the CommandManager. The book was written with SolidWorks Office Premium using version SP2.1
Below is an illustrated CommandManager for a default Assembly document. The default Assembly tabs are: Assembly, Layout, Sketch, Evaluate, and Office Products.

💡 The Office Products toolbar display is dependent on the activated Add-Ins.. during a SolidWorks session.

💡 If you have SolidWorks Office, SolidWorks Office Professional, or SolidWorks Office Premium, the Office Products tab is displayed in the CommandManager. The book was written with SolidWorks Office Premium using version SP2.1

The tabs replace the Control areas buttons from previous SolidWorks versions. The tabs that are displayed by default depend on the type of document open and the work flow customization that you have selected.

To customize the CommandManager tabs, right-click on a tab, and select the required custom option or select Customize CommandManager to access the Customize dialog box.

💡 DimXpert for parts provides the ability to graphically check if the model is fully dimensioned and tolerated.
FeatureManager Design Tree

The FeatureManager design tree is located on the left side of the SolidWorks Graphics window. The design tree provides a summarize view of the active part, assembly, or drawing document. The tree displays the details on how the part, assembly, or drawing document is created.

Understand the FeatureManager design tree to troubleshoot your model. The FeatureManager is use extensively throughout this book.

The FeatureManager consist of four default tabs:

- **FeatureManager design tree**.
- **PropertyManager**.
- **ConfigurationManager**.
- **DimXertManager**.

Select the Hide FeatureManager Tree Area arrows tab from the FeatureManager to enlarge the Graphics window for modeling.

Various commands provide the ability to control what is displayed in the FeatureManager design tree. They are:

1. Show or Hide FeatureManager items.

   Click **Options** from the Menu Bar toolbar. The System Options dialog box is displayed. Click **FeatureManager** from the System Options tab. Customize your FeatureManager from the Hide/Show Tree Items dialog box.

2. Filter the FeatureManager design tree. Enter information in the filter field. You can filter by: Type of features, Feature names, Sketches, Folders, Mates, User-defined tags, and Custom properties.

Tags are keywords you can add to a SolidWorks document to make them easier to filter and to search. The Tags icon is located in the bottom right corner of the Graphics window.
To collapse all items in the FeatureManager, right-click and select **Collapse items**, or press the **Shift + C** keys.

The FeatureManager design tree and the Graphics window are dynamically linked. Select sketches, features, drawing views, and construction geometry in either pane.

Split the FeatureManager and either display two FeatureManager instances, or combine the FeatureManager design tree with the ConfigurationManager or PropertyManager.

Move between the FeatureManager, PropertyManager, ConfigurationManager, and DimXpertManager by selecting the tabs at the top of the menu.

The ConfigurationManager tab is located to the right of the FeatureManager tab. Use the ConfigurationManager to create, select, and view multiple configurations of parts and assemblies.

The icons in the ConfigurationManager denote whether the configuration was created manually or with a design table.

The DimXpertManager tab provides the ability to insert dimensions and tolerances manually or automatically.

The DimXpertManager provides the following selections: **Auto Dimension Scheme**, **Show Tolerance Status**, **Copy Scheme**, and **TolAnalyst Study**.

**Fly-out FeatureManager**

The fly-out FeatureManager design tree provides the ability to view and select items in the PropertyManager and the FeatureManager design tree at the same time.

The fly-out FeatureManager provides the ability to select items which may be difficult to view or select from the Graphics window.
Another method for accessing a command is to use the short-cut key. Short-cut keys are special keystrokes which activates the drop-down menu options. Some commands in the menu bar and items in the drop-down menus have an underlined character. Press the Alt key followed by the corresponding key to the underlined character activates that command or option.

**Task Pane**

The Task Pane is displayed when a SolidWorks session starts. The Task Pane contains the following default tabs: SolidWorks Resources, Design Library, File Explorer, SolidWorks Search, View Palette, RealView, and Document Recovery.

The Document Recovery tab is only displayed in the Task Pane if your system terminates unexpectedly with an active document and if auto-recovery is enabled in the System Options section.

**SolidWorks Resources**

The basic SolidWorks Resources menu displays the following default selections: Getting Started, Community, Online Resources, and Tip of the Day.

Other user interfaces are available during the initial software installation selection: Machine Design, Mold Design, or Consumer Products Design.

**Design Library**

The Design Library contains reusable parts, assemblies, and other elements, including library features.

The Design Library tab contains four default selections. Each default selection contains additional sub categories. The default selections are: Design Library, Toolbox, 3D ContentCentral, and SolidWorks Content.

Click Tools, Add-Ins..., SolidWorks Toolbox and SolidWorks Toolbox Browser to activate the SolidWorks Toolbox.
To access the Design Library folders in a non network environment for a new installation, click Add File Location, enter: C:\Documents and Settings\All Users\Application Data\SolidWorks\SolidWorks 2008\design library. Click OK. In a network environment, contact your IT department for system details.

**File Explorer**

File Explorer duplicates Windows Explorer from your local computer and displays the following directories: Recent Documents, and Open in SolidWorks.

**Search**

SolidWorks Search is installed with Microsoft Windows Search and indexes the resources once before searching begins, either after installation, or when you initiate the first search.

The SolidWorks Search box is displayed in the upper right corner of the SolidWorks Graphics window. Enter the text or key words to search. Click the drop-down arrow to view the last 10 recent searches.

The Search tool in the Task Pane searches the following default locations: All Locations, Local Files, Design Library, SolidWorks Toolbox, and 3D ContentCentral.

Select any or all of the above locations. If you do not select a file location, all locations are searched.

**View Palette**

The View Palette tool located in the Task Pane provides the ability to insert drawing views of an active document, or click the Browse button to locate the desired document.
Click and drag the view from the View Palette into an active drawing sheet to create a drawing view.

💡 The (A) next to the drawing view informs the user that DimXpert Annotations are present.

**RealView**

RealView 📸 provides a simplified way to display models in a photo-realistic setting using a library of appearances and scenes. Note: RealView requires graphics card support and is memory intensive!

On RealView compatible systems, you can select Appearances and Scenes to display your model in the Graphics window. Drag and drop a selected appearance onto the model or FeatureManager. View the results in the Graphics window.

💡 PhotoWorks needs to be active to apply the scenes tool.

💡 RealView graphics is only available with supported graphics cards. For the latest information on graphics cards that support RealView Graphics display, visit: [www.solidworks.com/pages/services/videocardtesting.html](http://www.solidworks.com/pages/services/videocardtesting.html).

**Document Recovery**

Document Recovery 📷 provides the ability to save information files if the system terminates unexpectedly with an active document. The saved files are available on the Task Pane Document Recovery tab the next time you start a SolidWorks session. Note: Auto recovery is activated by default in the System Options section.

**Motion Study / Annotation tab**

The Motion Study tab is located in the bottom left corner of the Graphics window. Motion Study uses a key frame-based interface, and provides a graphical simulation of motion for the selected model.

💡 On older models, the Annotation tab replaces the Motion Study tab.
Click the Motion Study tab to view the MotionManager.

Click the Model tab to return to the FeatureManager design tree.

Create a New Part

A part is a 3D model which consists of features. What are features?

1. Features are geometry building blocks.
2. Features add or remove material.
3. Features are created from 2D or 3D sketched profiles or from edges and faces of existing geometry.

SolidWorks provides two modes in the New SolidWorks Document dialog box: Novice and Advanced.

The Novice Mode is the default mode with three default templates.

The Advanced Mode contains access to create additional templates. In this book, you will use the Advanced Mode.

Before you begin, create a SolidWorks folder as illustrated. Copy the files from the CD in the book. Use these folders and files to create your models!
Create the Standoff Part

**Tutorial: New Part - Standoff 1-2**

Create a New part named Standoff.

1. Click **New** from the Menu bar toolbar.

2. Click the **Advanced Mode** button from the New SolidWorks Document dialog box. The Templates tab is the default tab. Part is the default template from the New SolidWorks Document dialog box.

3. Click **OK** from the New SolidWorks Document dialog box. The Part FeatureManager is displayed.

   The Advanced mode remains selected for all new documents in the current SolidWorks session. The Advanced mode setting is saved when you exit SolidWorks. The default SolidWorks installation contains two tabs in the New SolidWorks Document dialog box: **Templates** and **Tutorial**.

   The Templates tab corresponds to the default SolidWorks templates. The Tutorial tab corresponds to the templates utilized in the SolidWorks Tutorials.

   In a SolidWorks session, the first system default part filename is named: Part1. The system attaches the .sldprt suffix to the created part. The second created part in the same session, increments to the filename: Part2. Part1 is displayed in the FeatureManager. The Menu Bar toolbar, Menu Bar menu and the CommandManager are displayed above the SolidWorks Graphics window. Note: Pin the Menu Bar toolbar and the Menu Bar menu. The Features icon and Features toolbar are selected by default in the Part mode.

   🌟 There are different SolidWorks products. The *SolidWorks Education Edition*, *SolidWorks Student Edition*, *SolidWorks Student Design Kit*, *SolidWorks*, *SolidWorks Office*, and the *SolidWorks Office Premium*. Each product produces a different header and displays different functions. This book can be used with all SolidWorks products.
The part Origin is displayed in blue in the center of the Graphics window. The Origin represents the intersection of the three default reference planes: *Front Plane*, *Top Plane*, and *Right Plane*. The positive X-axis is horizontal and points to the right of the Origin in the Front view. The positive Y-axis is vertical and points upward in the Front view. The FeatureManager contains a list of features, reference geometry, and settings utilized in the part.

💡 The Tags icon is displayed in the bottom right corner of the Graphics window. Tags are keywords you add to SolidWorks documents and features to make them easier to filter and search for.

💡 In this book, *Reference planes* and *Grid/Snaps* are deactivated in the Graphics window for improved model clarity.
Save the Standoff Part.

4. Click **Save** from the Menu bar toolbar.
5. Select the folder **VEXplorer Models**.
6. Enter **Standoff** for the File name in the VEXplorer Models folder. Note the Save as type.
7. Click **Save**.

💡 Organize parts into file folders. Copy and use the folders on the CD in the book. Create a separate sub folder for your solutions.

💡 In a SolidWorks application, each part, assembly, and drawing is referred to as a document. Each document is displayed in a separate Graphics window.

Define the Document Properties.

8. Click **Options** from the Menu bar toolbar. Click the **Document Properties** tab.
9. Select **ANSI** from the Dimensioning standard drop-down menu. Click **Units** in the left column. The Document Properties - Units dialog box is displayed.
10. Click **MMGS** (millimeter, gram, second) for Unit system as illustrated.
11. Select **12** for Length units decimal place from the drop-down menu. Select **None** for Angular units decimal place from the drop-down menu.
12. Click **OK** from the Document Properties - Units dialog box to return to the Graphics window.

Create the 2D Sketch plane for the part. The Sketch plane is the plane on which a sketch lies and is configurable through the Sketch Plane PropertyManager. In SolidWorks, the name used to describe a 2D or 3D profile is called a Sketch.

💡 The Reference Triad is located in the lower left corner of the Graphics window. The Reference Triad displays the orientation of the model coordinate axes; (Red-X, Green-Y, and Blue-Z) at all times when activated.
The Reference Triad aids you to display how the view orientation is displayed relative to the Front Plane.

Create a 2D Sketch.

13. Right-click **Front Plane** from the FeatureManager design tree. This is your Sketch plane. This is the Base sketch. The Context toolbar is displayed.

14. Click the **Sketch** tool. The Sketch toolbar is displayed in the CommandManager.

15. Click the **Circle** Sketch tool. The Sketch opens on the Front Plane in the Front view by default. The Circle PropertyManager is displayed.

16. Drag the **mouse pointer** into the Graphics window. The cursor displays the Circle feedback symbol. The center point of the circle is positioned at the Origin. The part Origin is displayed in the center of the Graphics window. The Origin represents the intersection of the three default reference planes. They are: Front Plane, Top Plane, and Right Plane. The positive X-axis is horizontal and points to the right of the Origin in the Front view. The positive Y-axis is vertical and points upward in the Front view.

💡 The Front Plane rotates, and is parallel to the screen. This only happens for your first sketch in a part.

17. Click the **Origin** from the Graphics window. This is the first point of the circle. The red dot feedback indicates the Origin point location. The mouse pointer displays the Coincident to point sketch relation feedback symbol.

18. Drag the **mouse pointer** to the right of the Origin.

19. Click a **position** to create the circle. Do not worry about the size.

💡 To control the Sketch relation display, click **View > Sketch Relations** from the Menu bar menu. Insert a Dimension.

20. Click **Smart Dimension** from the Sketch toolbar.

21. Click the **circumference** of the circle. The cursor displays the diameter feedback symbol.
22. Click a **position** to place the dimension in the Graphics window as illustrated.

23. Enter **10mm** the Modify dialog box. Click the **green check mark** from the Modify dialog box. The circular sketch is centered at the Origin.

24. Press the **f** key to fit the sketch to the Graphics window. Press the **z** key to Zoom out if needed. Press the **Z** key to Zoom in if needed.

💡 If your sketch is not correct, select **Undo** from the Menu bar toolbar.

The Extruded Boss/Base feature adds material to a part. The Extruded Base feature is the first feature of the Standoff part. An Extruded feature extends a profile along a path normal (⊥) to the profile plane for some distance. The movement along that path becomes the solid model. The 2D circle is sketched on the Front Plane.

Insert an Extruded Boss/Base Feature.

25. Click the **Features** tab from the CommandManager.

26. Click the **Extruded Boss/Base** tool from the Features toolbar. The Extrude PropertyManager is displayed. The Extrude PropertyManager displays the parameters utilized to define the feature.

27. Select **Mid Plane** for End Condition in Direction 1. The Mid Plane End Condition extrudes the sketch equally on both sides of the Sketch plane.

28. Enter **12mm** for Depth. The Depth defines the distance. Note the direction of the extrude relative to the Origin.

29. Click **OK** from the Extrude PropertyManager. Extrude1 is created and is displayed in the FeatureManager. Extrude1 is your Base feature.
To edit a feature, right-click the desired feature in the FeatureManager. Click Edit Feature. The PropertyManager is displayed.

Display an Isometric view.

30. Click Isometric view 🕒 from the Heads-up View toolbar.

The Extruded Cut feature removes material from a part. The Extruded Cut feature is the second feature of the Standoff part. An Extruded Cut extends a profile along a path normal (⊥) to the Sketch plane for some distance and removes material inside or outside the sketch. The 2D circle is sketched on the front face of the Standoff to create a hole.

Insert a Sketch.

31. Right-click the front face of Extrude1 in the Graphics window.

The selected face in the Graphics window is displayed in blue. Extrude1 is highlighted in the FeatureManager.

32. Click the Sketch 🕒 tool from the Context toolbar. The Sketch toolbar is displayed in the CommandManager.

33. Click the Circle 🏁 tool from the Sketch toolbar. The Circle 🏁 icon is displayed.

34. Click the Origin 🖐️.

35. Click a position to the right of the Origin as illustrated. The circle is created.

Insert a Dimension.

36. Click the Smart Dimension 🕒 tool from the Sketch toolbar.

37. Click the circumference of the circle. The cursor displays the diameter feedback symbol.

38. Click a position to locate the dimension in the Graphics window.

39. Enter 3 mm in the Modify dialog box.

40. Click the green check mark ✅ from the Modify dialog box. The circular sketch is centered at the origin. Insert an Extruded Cut feature.

41. Click the Features tab in the CommandManager.
42. Click the **Extruded Cut** tool from the Features toolbar. The Extrude PropertyManager is displayed.

43. Select **Through All** for End Condition in Direction 1.

44. Click **OK** from the Extrude PropertyManager. Extrude2 is displayed in the FeatureManager. You created your second feature. View the hole in the model.

Edit the color of the Standoff part.

45. Right-click the **Standoff** icon from the FeatureManager.

46. Click the **Appearance Callout** drop-down arrow.

47. Click **inside** the color box as illustrated. The Color and Optics PropertyManager is displayed.

48. Select a **color** from the Edit Color box as illustrated. You applied color to your model.

49. Click **OK** from the Color And Optics PropertyManager.

Modify a dimension in the model.

50. Click the **Extrude2** feature, “your second feature” in the FeatureManager. The Ø3 dimension is displayed.

51. Click the Ø3 dimension in the Graphics window.

52. Enter **1**.

53. Press the **f** key to fit the model to the Graphics window. Press the **z** key to zoom out.

Close the model.

54. Click **File, Close** from the Menu bar. Do not save the model as this time.

You completed the Standoff part using the Extruded Base/Boss feature with the Mid Plane End Condition option. The Extruded Cut feature was used to create a Through All hole. You also applied a color to the part with the Edit Color tool to control part and feature color and modified an existing dimension.
To edit a sketch, right-click the desired sketch in the FeatureManager. Click **Edit Sketch** from the Pop-up Context toolbar.

To edit a Feature, right-click the desired Feature in the FeatureManager. Click **Edit Feature** from the Pop-up Context toolbar.

---

**Create a New Assembly**

An assembly is a document that contains two or more parts. An assembly inserted into another assembly is called a sub-assembly. A part or sub-assembly inserted into an assembly is called a component. Create the Gear assembly consisting of the following components: **Standoff2** and **Gear28**.

Establishing the correct component relationship in an assembly requires forethought on component interaction. Mates are geometric relations that align and fit components in an assembly. Mates remove degrees of freedom from a component. Mates reflect the physical behavior of a component in an assembly. The components in the Gear assembly utilize Standard Mate types only.

**Tutorial: New Assembly - Gear 1-3**

Create a New assembly named Gear. First open the Standoff2 part.

1. Click **Open** from the Menu bar toolbar.

2. Double-click the **Standoff2** part from the VEXplorer Models folder. The part is displayed in the Graphics window. Note: You copied this folder from the CD in the book.

Note: Open a part. **Files of type:** Part(*prt,*sldprt).

Note: Open an Assembly. **Files of type:** Assembly(*asm,*sldasm).
Create a New Assembly.

3. Click **New** from the Menu bar toolbar.

4. Double-click the **Assembly icon** from the New SolidWorks Document dialog box. The Begin Assembly PropertyManager is displayed.

💡 The Begin Assembly PropertyManager is displayed when the Start command when creating new assembly option box is checked.

Insert the Standoff2 part.

5. Click **Standoff2** from the Part/Assembly to Insert box.

6. Click **OK** from the Begin Assembly PropertyManager. Assem1 is displayed in the FeatureManager. Standoff2 is fixed to the Origin (f). Note: <1> indicated the first instances.

7. Click the f key to fit the model to the Graphics window. If need to deactivate the display planes. Click **View**, uncheck **Planes** from the Menu bar menu. View the results.

8. Click **Isometric view** from the Heads-up View toolbar.

9. Click **Save As** from the Menu bar toolbar.

10. Select the **VEXplorer Model** folder.

11. Enter **Gear** for File name.

12. Click **Save**. The Gear Assembly FeatureManager is displayed.
Insert the Gear28 part.

13. Click the **Assembly** tab from the CommandManager.

14. Click the **Insert Components** tool from the Assembly toolbar. The Insert Component PropertyManager is displayed.

15. Click **Browse** from the Part/Assembly to Insert box.

16. Double-click the **Gear28** part from the VEXplorer Models folder. The Gear28 part is displayed in the Graphics window. Note: Select part for Files of type.

17. Click a **position** in the back of the Standoff2 component as illustrated.

18. Press the f key to fit the model to the Graphics window. Press the z key to zoom out.

19. Click and drag the **Gear28** component if required as illustrated.

Deactivate the Origins.

20. Click **View**, uncheck **Origins** from the Menu bar menu.

💡 The wheel mouse button or middle mouse button controls Zoom In/Out in the Graphics window. Use Ctrl + middle mouse button to Pan. Hold the middle mouse button down to rotate the model in the Graphics window.

   Insert a Concentric Mate between the Standoff2 and the Gear28 component. A Concentric mate forces two cylindrical faces to become concentric. The faces can move along the common axis, but cannot be moved away from this axis.

   Insert a Concentric Mate.

21. Click the **Mate** tool from the Assembly toolbar. The Mate PropertyManager is displayed.

22. Click the **inside cylindrical hole face** of Gear28 as illustrated. Note: the mouse pointer icon feedback for the selected face. Face<1>@Gear28 is displayed in the Mate Selections box.

23. Click the **long cylindrical face** of the Standoff2 component. The two selected faces are displayed in the Mate Selections box. The Concentric Mate type is selected by default.
24. The Standoff2 component is positioned concentric to the Gear28 hole. Click the green check mark \( \checkmark \) from the Pop-up Mate box. Concentric1 is created.

25. Click and drag Gear28 front to back. The Gear28 translates in and out along the Standoff2 component.

- Position the mouse pointer in the middle of the face to select the entire face. Do not position the mouse pointer near the edge of a face.

- If you select a wrong face or edge during the mate process, right-click in the Mate Selections box and select Clear Selections.

- If you delete a Mate and then recreate it, the Mate numbers will be in a different order.

A Coincident mate forces two planar faces to become coplanar. The faces can move along one another, but cannot be pulled apart. A Distance mate separates two planar faces by a specified value.

Insert a Distance Mate.

26. If required, clear the Mate Selections box.

27. Click the front circular face of the Gear28 component as illustrated.

28. Click the front circular face of the Standoff2 component as illustrated. The two selected faces are displayed in the Mate Selection box. Coincident is selected by default. Note: Use the Zoom to Area tool in the Heads-Up view toolbar if needed.

29. Click the Distance tool from the Mate pop-up box.

30. Enter 5 mm for Distance. Click the Flip Dimension button if required.
31. Click the **Green Check mark** from the Mate pop-up box. Distance1 is created.

32. Click **OK** from the Mate PropertyManager.

33. Press the **f** key to fit the model to the Graphics window.

34. Click **Isometric** from the Heads-up View toolbar.

35. **Expand** the Mates folder from the FeatureManager. View the created mates.

36. Click **Save**.

37. Click and drag the **front circular face** of Gear28. Gear28 is free to rotate about the Standoff2 component.

   - Press the **Shift+ z** keys to Zoom in on the model. Press the **z** key to Zoom out on the model.

---

**Create a New Assembly Drawing**

A SolidWorks drawing displays 2D and 3D views of a part or assembly. The foundation of a SolidWorks drawing is the drawing template. Drawing size, drawing standards, company information, manufacturing, and or assembly requirements, units and other properties are defined in the drawing template. In this section you will use the default drawing template.

The Sheet format is incorporated into the drawing template. The Sheet format contains the border, title block information, revision block information, company name and or logo information, Custom Properties and SolidWorks Properties. Because this section of the book is a Quick Start section, you will not address these items at this time.

Custom Properties and SolidWorks Properties are shared values between documents. Utilize an A-size Drawing Template with Sheet Format for the Gear assembly drawing.

A drawing contains views, geometric dimensioning, and tolerances, notes and other related design information. When a part or assembly is modified, the drawing automatically updates. When a dimension in the drawing is modified, the part or the assembly is automatically updated.

**Tutorial: New Drawing - Gear 1-4**

Create a New assembly drawing named Gear. Display the Front, Top, Right, and Isometric views.

1. Click **New** from the Menu bar toolbar.
2. Double-click the **Drawing** icon from the Templates tab.

3. Select **A-Landscape** from the Sheet Format/Size dialog box. Click **OK** from the Sheet Format/Size dialog box. The Model View PropertyManager is displayed.

4. Click **Cancel** from the Model View PropertyManager. The Draw1 FeatureManager is displayed. Set the Sheet1 Properties in the drawing.

   The Model View PropertyManager is displayed if the **Start command when creating new drawing option** is checked.

5. Right-click in **Sheet1**.

6. Click **Properties**. The Sheet Properties is displayed. Draw1 is the default drawing name. Sheet1 is the default first sheet name. The CommandManager alternates between View Layout, Sketch, and Annotation toolbars. The Model View PropertyManager is selected by default.

7. Select Sheet Scale **1:1**.

8. Select **Third angle** for Type of projection.

9. Click **OK** from the Sheet Properties dialog box. The A-Landscape paper is displayed in a new Graphics window. The sheet border defines the drawing size, 11” × 8.5” or (279.4mm × 215.9mm). The Drawings toolbar is displayed in the CommandManager.

Set the Document Properties.

10. Click **Options** from the Menu bar toolbar.

11. Click the **Document Properties** tab.

12. Select **ANSI** for Dimensioning standard from the drop-down menu.

13. Click **Units** from the left column.

14. Select **MMGS** (millimeters, gram, second) for Unit system.

15. Select **.12** for Length units decimal place from the drop-down menu.

16. Select **None** for Angular units decimal place from the drop-down menu.
17. Click **OK** from the Document Properties - Units dialog box.

💡 Detailing options provide the ability to address; dimensioning standards, text style, center marks, extension lines, arrow styles, tolerance and precision.

Save the Drawing.

18. Click **Save**.

19. Enter **Gear** for file name.

20. Click **Save**. The Gear drawing FeatureManager is displayed.

Insert the Drawing views using the View Palette.

21. Click the **View Palette** icon from the Task Pane.

22. Select **Gear** from the drop-down menu. Note: Gear is an active document. View the available views.

23. Drag the *Front view* on Sheet1 in the lower left corner.

24. Click a **position** directly above the Front view. The Top view is displayed.

25. Click a **position** directly to the right of the Front view. The Right view is displayed.

26. Click **OK** from the Projected View PropertyManager. The three views are displayed in Sheet1.

27. Drag the *Isometric view* from the View Palette directly above the Right view.

28. Click the **Shaded With Edges** icon from the Display Style box.

29. Click **OK** from the Drawing View4 PropertyManager. View the four created views.


31. Click **Save**.
Insert a Bill of Material into the Gear assembly drawing.

A drawing can contain a table-based Bill of Materials or an Excel based Bill of Materials, but not both.

32. Click the Annotation tab from the CommandManager.

33. Click Tables ➤ Bill of Materials from the Annotation toolbar. The Bill of Materials PropertyManager is displayed.

34. Click inside the Front view, Drawing View1. View the mouse pointer icon feedback symbol.

35. Click Top level only from the BOM Type box. Accept all other defaults.

36. Click OK from the Bill of Materials PropertyManager.

37. Click a position in the top left corner of Sheet1 to position the Bill of Materials as illustrated.

38. Click OK from the Bill of Materials PropertyManager.

39. Click inside Sheet1. Bill of Material1 is displayed in the FeatureManager. The Bill of Materials and Title block are incomplete. Complete the Gear drawing later as a homework problem.

40. Click Save.

41. Click Window ➤ Close All from the Menu bar menu.

42. Click File ➤ Exit from the Menu bar menu to close the SolidWorks session. You are finished with Chapter1. Review the SolidWorks Tutorials for additional information on parts, assemblies, and drawings.

**Summary**

In this chapter you learned about a Base sketch, Base feature, Extrude Cut features, refining the design, associativity, drawings, and geometric constraints. You started a SolidWorks session, and applied the SolidWorks User Interface (UI) and CommandManager. You created the Standoff2 part using the Extruded Base/Boss feature
with the Mid Plane End Condition option in Direction 1. You created an Extruded Cut feature with the Through All End Condition option to complete the part. You applied dimensions and modified these dimensions. You applied color to your part using the Color and Optics PropertyManager.

You created the Gear assembly with two components: Standoff2 and Gear28. You fixed the first inserted component to the Origin. You inserted the second component and then inserted a Concentric and Distance Mate.

You created an assembly drawing using the View Palette tool with a Front, Top, Right, and Isometric view. You modified the Isometric view with a Shaded with Edges Display Style. In the drawing you inserted a simple Bill of Materials. You have completed the first chapter of the book.

In Chapter 2, you’ll learn more features and sketching techniques required to create a Cover part and a Gear part used in the VEXplorer model.

**Key terms**

- **Associativity.** Assures that changes incorporated in one document or drawing view are automatically made to all other related documents and drawing views.

- **Base feature.** The first feature of a part is called the Base feature.

- **Base sketch.** The first sketch of a part is called the Base sketch. The Base sketch is the foundation for the 3D model. Create a 2D sketch on a default plane: Front, Top, and Right in the FeatureManager design tree, or on a created plane.

- **ConfigurationManager.** Located on the left side of the SolidWorks Graphics window is a used to create, select, and view multiple configurations of parts and assemblies in a document.

- **Constraints.** Geometric relations such as Perpendicular, Horizontal, Parallel, Vertical, Coincident, Concentric, etc. Insert constraints to your model to incorporate design intent.

- **Coordinate system.** A system of planes used to assign Cartesian coordinates to features, parts, and assemblies. Part and assembly documents contain default coordinate systems; other coordinate systems can be defined with reference geometry. Coordinate systems can be used with measurement tools and for exporting documents to other file formats.

- **Design intent.** Design intent is the intellectual arrangements of features and dimensions of a design. Design intent governs the relationship between sketches in a feature, features in a part, and parts in an assembly.

- **Design Library.** Located in the Task Pane, the Design Library provides a central location for reusable elements such as parts, assemblies, etc.
• **Drawing.** A 2D representation of a 3D part or assembly. The extension for a SolidWorks drawing file name is .SLDDRW.

• **Document.** A file containing a part, assembly, or drawing.

• **Features.** Individual shapes created by Sketch Entities tools: lines, circles, rectangles, etc. that when combined, creates the part. Features are geometry building blocks, they add or remove material, and are created from 2D or 3D sketched profiles or from edges and faces of existing geometry.

• **FeatureManager design tree.** Located on the left side of the SolidWorks Graphics window and provides an outline view of the active part, assembly, or drawing. The FeatureManager design tree and the Graphics window are dynamically linked. You can select features, sketches, drawing views, and construction geometry in either pane.

• **Fly-out FeatureManager design tree.** Allows you to view and select items in the PropertyManager and the FeatureManager design tree at the same time.

• **Extruded Boss/Base.** A feature that adds material to a part or an assembly.

• **Extruded Cut.** A feature that removes material from a part or an assembly.

• **Parameter.** A value used to define a sketch or feature, often a dimension or instance.

• **Rollback.** Suppresses all items below the rollback bar.

---

### Check your understanding

1. Identify the following feature icon 🎨.

2. Identify the following feature icon 🖌️.

3. Identify the following sketch icon 🎨.

4. Identify the following sketch icon ✏️.

5. Identify the number of instances in the illustrated model.

6. SolidWorks provides system feedback by attaching a symbol to the mouse pointer cursor arrow. The following system feedback symbol 🌐 indicates a _____.

7. The following system feedback symbol 🎨 indicates a _____.

8. In a SolidWorks session, the first system default part filename is named ______.

9. SolidWorks attaches the _______ suffix to a part document.

10. SolidWorks attaches the _______ suffix to an assembly document.

11. SolidWorks attaches the _______ suffix to a drawing document.

12. Describe the Base feature.
13. Describe the Base sketch.
15. Describe a component.
16. Describe a Coincident Mate.
17. Describe a Distance Mate.
18. True or False. Mates remove degrees of freedom from a component. Mates reflect the physical behavior of a component in an assembly.
19. True or False. The FeatureManager provides a summarized view of the active part, assembly, or drawing. The FeatureManager displays the details on how the part, assembly, or drawing was created.
20. True or False. Constraints are geometric relations such as Perpendicular, Horizontal, Parallel, Vertical, Coincident, and Concentric.
21. True or False. The (f) symbol next to the component name Cover_Hole<1> means first component.